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ΤΟ ∆ΙΑ∆ΡΑΣΤΙΚΟ ΠΕΡΙΒΑΛΛΟΝ ΕΡΓΑΣΙΑΣ 
ΤΟΥ MATLAB 
 

Έναρξη - Τερµατισµός 
 
Η έναρξη της λειτουργίας του MatLab εξαρτάται από το λειτουργικό σύστηµα.  
 
Στα συστήµατα UNIX πληκτρολογούµε στη προτροπή του συστήµατος (%): matlab 
 
Στα συστήµατα WINDOWS η έναρξη γίνεται: 
� από το εικονίδιο MatLab:    στην επιφάνεια εργασίας, 
� από το µενού:   Έναρξη > Όλα τα Προγράµµατα > MATLAB, ή,   
� πληκτρολογώντας στη προτροπή του DOS (>): matlab. 

 
Το κύριο παράθυρο της εφαρµογής περιέχει πολλά επί µέρους παράθυρα. Για παράδειγµα, 
στην παρακάτω εικόνα βλέπουµε τέσσερα από αυτά: Το Command Window (παράθυρο 
εντολών - CW) είναι το βασικό παράθυρο όπου δίνουµε όλες τις εντολές και παίρνουµε τα 
αποτελέσµατα, το Command History περιέχει το ιστορικό των εντολών που δώσαµε, το 
Workspace (περιοχή εργασίας) περιέχει τα ονόµατα και τις τιµές όλων των µεταβλητών που 
έχουµε χρησιµοποιήσει και το Current Directory παρουσιάζει τα περιεχόµενα του φακέλου 
µέσα στον οποίο αναπτύσσουµε την εφαρµογή µας. Υπάρχουν και άλλα βοηθητικά παράθυρα, 
π.χ., για τις γραφικές παραστάσεις, για την εµφάνιση των πινάκων, ο editor των 
προγραµµάτων, κ.ά., τα οποία θα παρουσιάσουµε παρακάτω.  
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Όταν το MatLab ξεκινά έχει σαν αρχικό φάσκελο εργασίας τον c:\matlab\work, και, 
εφόσον υπάρχει εκεί, εκτελεί το αρχείο startup.m. Αν δεν υπάρχει θα ελέγξει και στο φάκελο 
c:\matlab\toolbox\local. Με αυτό τον τρόπο το MatLab µας δίνει τη δυνατότητα να 
ρυθµίσουµε την εκκίνηση του, τοποθετώντας στο αρχείο startup.m τις εντολές που επιθυµούµε 
να εκτελούνται πρώτες. 
 
Ο τερµατισµός της εφαρµογής MatLab γίνεται είτε από το µενού:   File > Exit MATLAB, 
ή,  δίνοντας στο Command Window την εντολή exit ή quit: 
 
 Command Window 

>> exit  ↵ 

ή 

>> quit  ↵ 

 
Η εντολή exit τερµατίζει αµέσως την εφαρµογή και ισοδυναµεί µε το πλήκτρο Χ στην επάνω 
δεξιά γωνία του παράθυρου της εφαρµογής. 
 
Αντίθετα η quit είναι πιο σταδιακή καθώς εκτελεί πρώτα ένα αρχείο µε εντολές τερµατισµού, 
το finish.m, στο οποίο µπορούµε να τοποθετήσουµε εντολές οι οποίες αποθηκεύουν την 
περιοχή εργασίας µας µε όλες τις τρέχουσες τιµές των µεταβλητών, κλείνουν τα ανοιχτά 
αρχεία, ολοκληρώνουν τα γραφικά, και γενικά εξασφαλίζουν την οµαλή συνέχεια της εργασίας 
µας την επόµενη φορά που θα χρησιµοποιήσουµε το MatLab. 
 
Ένας συχνός συνδυασµός των δύο αρχείων είναι, το µεν finish.m να έχει την εντολή save που 
αποθηκεύει όλες τις τρέχουσες µεταβλητές από τη µνήµη στο αρχείο matlab.mat, το δε 
startup.m να έχει την εντολή load η οποία φορτώνει το αρχείο matlab.mat στη µνήµη. 
 

Βοήθεια & Πληροφορίες 
 
Για οποιαδήποτε βοήθεια ή διευκρίνιση το MatLab διαθέτει όλες τις απαραίτητες οδηγίες 
παραδείγµατα και πληροφορίες κάτω από το µενού:  Help > MatLab Help (F1) 
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Επίσης, στο Command Window η εντολή help µας δίνει σαν απάντηση µια λίστα µε όλες τις 
διαθέσιµες εντολές της εφαρµογής.: 
 
 Command Window 

>> help  ↵ 
HELP topics 
 
matlab\general       -  General purpose commands. 
matlab\ops           -  Operators and special characters. 
matlab\lang          -  Programming language constructs. 
matlab\elmat         -  Elementary matrices and matrix 
manipulation. 
matlab\elfun         -  Elementary math functions. 
matlab\specfun       -  Specialized math functions. 
matlab\matfun        -  Matrix functions - numerical linear 
algebra. 
… … …  

 
Για να ζητήσουµε βοήθεια για µια συγκεκριµένη εντολή γράφουµε αµέσως µετά την εντολή 
help το όνοµά της εντολής: 
 
 Command Window 

>> help exit  ↵ 
EXIT   Exit from MATLAB. 
    EXIT terminates MATLAB. 
  
    See also quit. 
>>  

 
To MatLab διαθέτει Επιπλέον διάφορα παραδείγµατα για κάθε κατηγορία προβλήµατος, 
προσβάσιµα από το µενού: Help > Demos, ή,  στο Command Window µε την εντολή 
demo: 
 
 Command Window 

>> demo  ↵ 
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Τα Παράθυρα του Περιβάλλοντος Εργασίας 
 

Το Παράθυρο Εντολών (Command Window) 
 
Το Command Window (ή CW για συντοµία) είναι το κύριο µέσο επικοινωνίας του χρήστη µε 
την εφαρµογή MatLab. Εδώ δίνονται οι εντολές και επιστρέφονται όσα αποτελέσµατα δεν 
απαιτούν ειδικό παράθυρο γραφικών. 
 

 
 
Το Command Window (CW) χρησιµοποιεί το σύµβολο ( >> ) για να δείξει στον χρήστη ότι 
περιµένει εντολές (προτροπή - prompt). Για να είναι πιο ευδιάκριτες οι εντολές που θα δίνει ο 
χρήστης ( ↵ ) και τα αποτελέσµατα που θα παίρνει, στο βιβλίο αυτό το CW παρουσιάζεται 
πάντοτε µε την παρακάτω µορφή: 
 
 Command Window 

>>  3 + 4  ↵ 
ans = 
      7 
>>  b = 10 * ans  ↵ 
b = 
    70 
>> 
>> a = sin(pi/2)  ↵ 
a = 
     1 
>>    

 

Το Ιστορικό των Εντολών (Command History) 
 
Όλες οι εντολές που δίνουµε στο CW αποθηκεύονται σε µια λίστα µα τη σειρά που δόθηκαν. 
Από το παράθυρο του CW έχουµε πρόσβαση σε όλες τις προηγούµενες εντολές µε τα βέλη 
του πληκτρολογίου (άνω - κάτω). Η λίστα µε το ιστορικό των εντολών περιέχεται και στο 
παράθυρο Command History όπου µπορούµε να επιλέξουµε µια εντολή ή ένα σύνολο 
εντολών για εκτέλεση ή για αποθήκευση σε αρχείο, κλπ. 
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Η Περιοχή Εργασίας (Workspace) 
 

 
 
 
Το παράθυρο Workspace περιέχει όλες τις µεταβλητές και τα µητρώα που χρησιµοποιούµε 
στην εργασία µας και µας πληροφορεί για τις ιδιότητές τους όπως για παράδειγµα την τιµή, 
την ακρίβεια, τις διαστάσεις, κλπ. Επίσης, διαθέτει µενού και εντολές για τη διαγραφή, την 
εµφάνιση, τη σχεδίαση, ή και την εκτύπωσή τους. Τα περιεχόµενα του Workspace 
εµφανίζονται και στο CW µε τις εντολές who & whos: 
 
 
 Command Window 

>> who 
Your variables are: 
a    ans  b     
 
>> whos 
  Name      Size                    Bytes  Class 
 
  a         1x1                         8  double array 
  ans       1x1                         8  double array 
  b         1x1                         8  double array 
 
Grand total is 3 elements using 24 bytes 
>>  
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Το Παράθυρο Φακέλων και Αρχείων (Current Directory) 
 

 
 
 
Το παράθυρο Current Directory δείχνει τα περιεχόµενα του φακέλου στον οποίο 
εργαζόµαστε και στον οποίο θα αποθηκευτούν τα αρχεία µας, τα δεδοµένα, τα αποτελέσµατα 
και ότι άλλο αποτελεί το τρέχον έργο µας. Τα περιεχόµενα του Current Directory 
εµφανίζονται και στο CW µε τις εντολές dir & ls. 
 
 Command Window 

>> dir 
.               help            rtw             webserver        
..              ja              simulink        work             
MATLAB 7.0.lnk  java            stateflow        
bin             jhelp           sys              
demos           license.txt     toolbox          
extern          notebook        uninstall        
>>  

 
 

Ο Επεξεργαστής Κειµένου & Προγραµµάτων (Editor/Debugger) 
 

 
 
Αν και όλοι οι Η/Υ διαθέτουν κάποιον επεξεργαστή κειµένου, το MatLab έρχεται µε τον δικό 
του Editor ο οποίος παρέχει στον χρήστη πολλές επιπλέον ευκολίες για την ανάπτυξη των 
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προγραµµάτων του (.m αρχεία) και λειτουργεί και σαν debugger. Έτσι, µπορούµε να 
παρακολουθήσουµε την ροή εκτέλεσης του προγράµµατος και να πληροφορηθούµε τις τιµές 
που παίρνουν οι µεταβλητές. 
 

Ο Επεξεργαστής Μητρώων (Array Editor) 
 

 
 
 
Το MatLab κάνει εκτεταµένη χρήση των µητρώων γι’ αυτό και διαθέτει ειδικό παράθυρο για 
την εµφάνιση και την επεξεργασία τους. Ο επεξεργαστής µητρώων ενεργοποιείται από τη 
περιοχή εργασίας αυτόµατα µόλις επιλέξουµε το µητρώο που µας ενδιαφέρει. Επιπλέον, ο 
Array Editor µπορεί να παρουσιάσει ένα µητρώο µε 2-D ή 3-D γραφικά.  
 
Όλα τα παράθυρα του MatLab µπορούν να αποσπαστούν από το κεντρικό παράθυρο της 
εφαρµογής και να τοποθετηθούν οπουδήποτε στην επιφάνεια εργασίας. 
 

 
 
Στη συνέχεια του βιβλίου, και στο µεγαλύτερο µέρος του, θα χρησιµοποιούµε κυρίως το 
Command Window (CW), στο οποίο δίνουµε τις εντολές και παίρνουµε τα περισσότερα 
αποτελέσµατα, και τον Editor, στον οποίο συντάσσουµε τα προγράµµατα µας. Για το λόγο 
αυτό θα παρουσιάσουµε τη λειτουργία τους µε περισσότερη λεπτοµέρεια στο τµήµα που 
ακολουθεί. 
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Βασική Χρήση και Ρυθµίσεις του Command Window 
 
Η πραγµατοποίηση απλών υπολογισµών στο MatLab είναι πολύ εύκολη. Το CW λειτουργεί 
σαν µεταφραστής (Interpreter) που µετατρέπει κάθε µας εντολή σε γλώσσα µηχανής, την 
εκτελεί, και αµέσως κάτω από την εντολή γράφει το αποτέλεσµα. 
 

Οι Βασικές Πράξεις (+), (-), (*), (/) & (^) 
 
Οι πράξεις µε αριθµούς γράφονται όπως σε οποιαδήποτε άλλη γλώσσα προγραµµατισµού και 
εκτελούνται άµεσα. Το αποτέλεσµα (ans =) δίνεται αµέσως από κάτω από την εντολή. 
 
 Command Window: 

>> 2+3*5^2  ↵ 
ans = 
    77 
>> 

 
Η σειρά εκτέλεσης των πράξεων είναι η ίδια σε όλες τις γλώσσες προγραµµατισµού, δηλαδή,  
πρώτα γίνεται η ύψωση σε δύναµη (^), µετά οι πολλαπλασιασµοί (*) και οι διαιρέσεις (/), και 
τέλος, οι προσθέσεις (+) και οι αφαιρέσεις (-). Η σειρά µπορεί να αλλάξει µε τη χρήση 
παρενθέσεων οι οποίες προηγούνται αρχίζοντας πρώτα από τη πιο εσωτερική. 
 

Για παράδειγµα η παράσταση:  
( )

2
343 61.33 1 10

11.2 2 3 / 4
⎛ ⎞−
⋅ + ⋅⎜ ⎟⎜ ⎟⋅ +⎝ ⎠

 ,  δίνεται ως εξής: 

 Command Window: 

>> 1.33*(1+(43-6^2)/(11.2*(2+3/4)))*10^3  ↵ 
ans = 
  1.6323e+003 
>>  

 

Τα Ειδικά Σύµβολα  (…), (,) & (;) 
 
Αν µια εντολή δεν χωράει σε µια γραµµή, µπορεί να συνεχίσει στις επόµενες εφόσον στο 
τέλος κάθε µιας τοποθετηθούν αποσιωπητικά (…). 
 
 Command Window: 

>> 1.33*(1+(43-6^2)/ ...  ↵ 
(11.2*(2+3/4)))*10^3      ↵ 
ans = 
  1.6323e+003 
>> 
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Κάθε γραµµή µπορεί να περιέχει περισσότερες από µία εντολές, εφόσον αυτές διαχωρίζονται 
µεταξύ τους µε κόµµα (,).   
 
 Command Window: 

>> 2+3, 4^2  ↵ 
ans = 
     5 
ans = 
    16 
>> 

 
Σε κάθε εντολή που δίνουµε στο CW, το MatLab απαντά µε το αποτέλεσµα της Αυτό δεν 
είναι πάντοτε επιθυµητό, ειδικά για ενδιάµεσους υπολογισµούς. Η απάντηση του MatLab 
(έξοδος)  µπορεί να απενεργοποιηθεί µε τη τοποθέτηση ενός ερωτηµατικού (semicolon) (;) 
στο τέλος κάθε εντολής. Στη περίπτωση αυτή, παρόλο που δεν βλέπουµε το αποτέλεσµα, 
αποθηκεύεται στην ειδική µεταβλητή ans και µπορεί να χρησιµοποιηθεί στη συνέχεια των 
υπολογισµών. 
 
 Command Window: 

>> 1.33*(1+(43-6^2)/(11.2*(2+3/4)))*10^3;  ↵ 
>> 
… … …  
>> ans  ↵ 
ans = 
  1.6323e+003 

 

Οι Ειδικές Μεταβλητές 
 
Το MatLab έχει ορισµένες ειδικές µεταβλητές όπως είναι οι: pi (π), eps, ans, i, j, κλπ.  
 
Η µεταβλητή pi περιέχει τον αριθµό π = 3.14159… . Μπορούµε να δούµε τη τιµή του 
αριθµού π (pi) στο CW ή να τον χρησιµοποιήσουµε σε τριγωνοµετρικές πράξεις: 
 
 Command Window: 

>> pi  ↵ 
ans = 
    3.1416 
>> sin(pi/2)  ↵ 
ans = 
     1 
>> help pi  ↵ 
 PI     3.1415926535897.... 
    PI = 4*atan(1) = imag(log(-1)) = 3.1415926535897.... 
    Reference page in Help browser 
       doc pi 
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Στο MatLab όλοι οι υπολογισµοί γίνονται µε διπλή ακρίβεια, δηλαδή περίπου δεκαέξι ψηφίων 
για κάθε αριθµό, σε 32-bit µηχανές. Η µικρότερη διαφορά που διακρίνει δυο αριθµούς 
εξαρτάται από το σφάλµα στρογγυλοποίησης της συγκεκριµένης υπολογιστικής µηχανής 
(computer) και λέγεται eps.  
 
 Command Window: 

>> computer  ↵ 
ans = 
PCWIN 
>> eps  ↵ 
ans = 
  2.2204e-016 
>>  

 
Όταν οι εντολές του CW εκτελούν πράξεις χωρίς να αναθέτουν (=) το αποτέλεσµά σε µια 
µεταβλητή, τότε το αποτέλεσµα τους αποθηκεύεται πάντα στη µεταβλητή ans. 
 
 Command Window: 

>> x = 1+2 ,  2+3  ↵ 
x = 
     3 
ans = 
     5 
>> 

 
Το MatLab διαθέτει µιγαδικούς αριθµούς και συγκεκριµένα, εφόσον δεν έχουν οριστεί 
διαφορετικά, οι µεταβλητές  i  και  j  αντιστοιχούν στη τετραγωνική ρίζα του -1 ( sqrt(-1) ). 
 
 Command Window: 

>> i  ↵ 
ans = 
        0 + 1.0000i 
>> j  ↵ 
ans = 
        0 + 1.0000i 
>> i^2  ↵ 
ans = 
    -1 
>> help i  ↵ 
I Imaginary unit. 
  As the basic imaginary unit SQRT(-1), i and j are used to enter 
  complex numbers.  For example, the expressions 3+2i, 3+2*i, 3+2j, 
  3+2*j and 3+2*sqrt(-1) all have the same value. 
  
  Since both i and j are functions, they can be overridden and used 
  as a variable.  This permits you to use i or j as an index in FOR 
  loops, etc. 
  
  See also j. 
>> 
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Μεταβλητές 
 
Στους απλούς υπολογιστές χειρός (calculators) τα αποτελέσµατα εµφανίζονται στην οθόνη και 
όταν πραγµατοποιήσουµε την επόµενη πράξη τα προηγούµενα διαγράφονται για να 
εµφανιστεί το νέο αποτέλεσµα.  
 
Αυτό δεν συµβαίνει στις γλώσσες προγραµµατισµού και στο MatLab. Εδώ τα αποτελέσµατα 
των πράξεων ή των εντολών αποθηκεύονται στη µνήµη της περιοχής εργασίας µας, το κάθε 
ένα µε άλλο όνοµα, ώστε να µπορούν να ανακληθούν αργότερα. Τα ονόµατα αυτά, που 
αναφέρονται στις θέσεις µνήµης και περιέχουν κάποια τιµή, λέγονται µεταβλητές. 
 
Τα ονόµατα των µεταβλητών αποτελούνται από Λατινικά γράµµατα (a-z, A-Z), αριθµούς (0-
9) και το σύµβολο ( _ ). Το µέγιστο µήκος των ονοµάτων είναι 63 χαρακτήρες και δεν πρέπει 
να συµπίπτουν µε δεσµευµένες λέξεις ή εντολές του MatLab. 
 
Στο MatLab τα κεφαλαία γράµµατα διακρίνονται από τα αντίστοιχα πεζά (case sensitive). 
∆ηλαδή, το “y” και το “Y” είναι διαφορετικές µεταβλητές και έχουν διαφορετικές τιµές.  
 
Η ανάθεση τιµών στις µεταβλητές γίνεται µε το σύµβολο ίσον (=). Αριστερά του τοποθετείται 
το όνοµα της µεταβλητής και δεξιά του η αλγεβρική παράσταση. Μόνο ένα όνοµα 
µεταβλητής επιτρέπεται σε κάθε ανάθεση. Π.χ.: 
 
 
 Command Window: 

>> imax = 10;  ↵ 
>> xronos = 0.0;  ↵ 
>> embado_trigwnou = 0.5 * basi * ypsos;  ↵ 
>> A3 = 3.0;  ↵  

 
 
Οι µεταβλητές του MatLab δεν χρειάζονται ειδικές δηλώσεις, όπως στις γλώσσες 
προγραµµατισµού, αλλά δηµιουργούνται αυτόµατα στη περιοχή εργασίας (Workspace) 
µόλις τους γίνει η πρώτη ανάθεση τιµής. 
 
 
Για να γράψουµε µια πιο σύνθετη παράσταση µπορούµε να χρησιµοποιήσουµε και 
περισσότερες από µια ενδιάµεσες µεταβλητές. Όπως για παράδειγµα, η παρακάτω συνάρτηση 
µπορεί να γραφτεί: 
 

3 2

2

3 7
0.5 4.5

x x xf
x x
− + −

=
+ −

 

 
 
 
 Command Window: 
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>> x = 5;  ↵ 
>> arithmitis = x^3-3*x^2+x-7;  ↵ 
>> paronomastis = x^2+0.5*x-4.5;  ↵ 
>> f = arithmitis / paronomastis  ↵ 
f = 
    2.0870 
>>  

 

Η Περιοχή Εργασίας (Workspace) 
 
Όλες οι µεταβλητές που χρησιµοποιούµε βρίσκονται στη περιοχή εργασίας (Workspace). Τα 
περιεχόµενά της εµφανίζονται στο παράθυρο Workspace. Για παράδειγµα το Workspace 
που δηµιουργήθηκε που τις προηγούµενες εντολές θα περιέχει 4 µεταβλητές:  
 

 
 
 
 
Η διαγραφή µιας µεταβλητής γίνεται µε την εντολή clear και το όνοµα της µεταβλητής. Η 
εντολή clear σκέτη διαγράφει όλες τις µεταβλητές από το Workspace.  
 
 Command Window: 

>> clear x  ↵ 

 
Οι τιµές των µεταβλητών µπορούν να εξαχθούν και να αποθηκευτούν σε αρχεία κειµένου 
(text)    µε την εντολή save. Για να αποθηκεύσουµε τη τιµή της  f  στο αρχείο “times_f.txt” 
δίνουµε: 
 
 Command Window: 

>> save  times_f.txt  f  -ascii  ↵ 

 
και το αρχείο που δηµιουργείται θα περιέχει: 
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H εντολή save σκέτη αποθηκεύει όλο το workspace µε τις µεταβλητές σε ένα αρχείο µε το 
όνοµα matlab.mat. Το αρχείο αυτό µπορούµε να το επαναφέρουµε αργότερα µε την εντολή 
load, και να συνεχίσουµε την εργασία µας. 
 
 Command Window: 

>> save  ↵ 
 
Saving to: matlab.mat 
 
>> load  ↵ 
 
Loading from: matlab.mat 
 
>> 

 

Ρυθµίσεις 
 
Όταν το CW έχει πάρα πολλά στοιχεία (εντολές, αποτελέσµατα, κλπ.) µπορούµε να το 
καθαρίσουµε µε την εντολή clc. Αν τα στοιχεία αυτά είναι χρήσιµα µπορούµε να κρατάµε 
παράλληλα ένα αντίγραφο του CW σε αρχείο κειµένου ε την εντολή diary (on/off). 
 
Οι γραµµές των εντολών στο CW έχουν µεταξύ τους ένα κενό ώστε να είναι πιο ευδιάκριτες 
αλλά αυτό επιµηκύνει τις απαντήσεις και καταλαµβάνουν πιο πολύ χώρο στο παράθυρο. Η 
εντολή format compact αφαιρεί το ενδιάµεσο κενό ενώ η εντολή format loose το 
επαναφέρει. 
 
 Command Window: 

>> format loose  ↵ 
>> pi 
 
ans = 
 
    3.1416 
 
>> format compact  ↵ 
>> pi 
ans = 
    3.1416 
>> 
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Τα αριθµητικά αποτελέσµατα του MatLab είναι διπλής ακρίβειας. Αυτό σηµαίνει ότι κάθε 
αριθµός µπορεί να έχει και 16 σηµαντικά ψηφία αλλά δεν είναι δυνατόν να εκτυπώνονται 
πάντοτε όλα τα ψηφία στο CW. Με την εντολή format short ή format long ρυθµίζουµε το 
πλήθος των εµφανιζόµενων ψηφίων που επιθυµούµε. 
 
 Command Window: 

>> format long, a = sqrt(2) ↵ 
a = 
   1.41421356237310 
>> format short, a = sqrt(2) ↵ 
a = 
    1.4142 

 
Αν οι αριθµοί πρέπει να εµφανίζονται σε µορφή εκθετικού (π.χ. 1.0Ε+2) τότε 
χρησιµοποιούµε αντίστοιχα τις εντολές format short e ή format long e. 
 
Τέλος, οποιαδήποτε εντολή ή ενέργεια που έχουµε δώσει µπορεί να ακυρωθεί ή να διακοπεί 
µέσα από το CW, αν δώσουµε µε το πληκτρολόγιο την εντολή  ^C ή ctrl-C. 
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ΕΠΙΛΥΣΗ ΑΠΛΩΝ ΠΡΟΒΛΗΜΑΤΩΝ ΣΤΟ 
MATLAB ΜΕ ΑΚΟΛΟΥΘΙΕΣ ΕΝΤΟΛΩΝ 
 
 
Στο MatLab µπορούµε να λύσουµε ένα πρόβληµα χωρίς να κατασκευάσουµε απαραίτητα 
κάποιο πρόγραµµα. Απλά εκτελούµε τα βήµατα της λύσης, όπως θα κάναµε και µε το χέρι, µε 
τη µορφή εντολών στο CW.  
 
Το βασικό κέρδος από την απλή αυτή χρήση του MatLab είναι ότι, (α) όλα τα αποτελέσµατα 
αποθηκεύονται στο Workspace και είναι διαθέσιµα κάθε στιγµή για να ξαναχρησιµοποιηθούν, 
(β) όλες οι εντολές αποθηκεύονται στο History και είναι διαθέσιµες κάθε στιγµή για να 
ξαναδοθούν ή να διορθωθούν, και, (γ) µπορούµε να δοκιµάσουµε εύκολα και γρήγορα 
πολλούς τρόπους λύσης ώστε να καταλήξουµε στο βέλτιστο τρόπο για το πρόβληµα µας.  
 
Ακόµη και όταν αναπτύσσουµε προγράµµατα στο MatLab είναι καλό, πρώτα να δοκιµάζουµε 
τις πιο σύνθετες εντολές τους στο CW, ώστε να είµαστε βέβαιοι για τη σωστή υλοποίησή και 
τα αποτελέσµατά τους, κα, µετά να τις ενσωµατώνουµε στο πρόγραµµα. 
 

Απλοί υπολογισµοί και εντολές ορισµού ή ανάθεσης 
 

Παράδειγµα 1: Μετατροπή Μοιρών σε Ακτίνια 
 
Για να µετατραπούν οι µοίρες σε ακτίνια εφαρµόζεται η σχέση:  
 

180 180
aktinia moires moiresaktinia π
π

⋅
− ⇔ =  

 
Έστω ότι πρέπει να µετατραπούν οι 45ο σε ακτίνια. ∆ίνουµε τη τιµή 45 σε µια µεταβλητή 
(moires) και στη συνέχεια δίνουµε τον τύπο υπολογισµού:  aktinia = moires * pi / 180. Το 
αποτέλεσµα θα είναι 0.7854, που ισούται µε το  π/4. 
 
 Command Window: 

>> moires = 45 ↵ 
moires = 
    45 
>> aktinia = moires * pi / 180 ↵ 
aktinia = 
    0.7854 
>> pi/4 ↵ 
ans = 
    0.7854 
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Παράδειγµα 2: Μετατροπή θερµοκρασίας οC σε οF 
 
Ο τύπος µετατροπής από βαθµούς Κελσίου σε Φαρενάιτ είναι:  F = 32 + C * 9/5.  
Αν C = 36.6 τότε το F θα είναι: 
 
 
 Command Window: 

>> C = 36.6; F = 32+C*9/5  ↵ 
F = 
   97.8800 

 
 

Παράδειγµα 3: Απόσταση µεταξύ 2 σηµείων 
 
Τα δύο σηµεία S1 & S2 έχουν συντεταγµένες στο επίπεδο Χ-Υ:  S1(x1, y1) & S2(x2, y2). Η 
απόσταση µεταξύ τους είναι (Πυθαγόρειο θεώρηµα):   
 

( ) ( )2 2
2 1 2 1d x x y y= − + −  

 
Έστω ότι µας δίνονται τα δύο σηµεία S1(1,6) & S2(4,8), ο υπολογισµός της απόστασης στο 
MatLab θα έχει ως εξής:   
 
 
 Command Window: 

>> x1 = 1; y1 = 4; x2 = 3; y2 = 8;  ↵ 
>> d = sqrt( (x2-x1)^2 + (y2-y1)^2 )  ↵ 
d = 
    4.4721 

 
 

Παράδειγµα 4: Μετατροπή Καρτεσιανών συντεταγµένων σε Σφαιρικές 
 
Οι τύποι µετατροπής των Καρτεσιανών συντεταγµένων σε σφαιρικές είναι:  
 

2 2 , τοξεφ YR X Y F
X

⎛ ⎞= + = ⎜ ⎟
⎝ ⎠

 

 
Το τοξεφ() στο MatLab είναι η συνάρτηση atan(). Αν X = 4 & Y = 4 η ακτίνα R και η γωνία 
F θα είναι: 
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 Command Window: 

>> X = 4; Y = 4;  ↵ 
>> R = sqrt(X^2+Y^2), F = atan(Y/X)  ↵ 
R = 
    5.6569 
F = 
    0.7854 

 

Εσωτερικές Συναρτήσεις  
 
Στα παραδείγµατα 3 και 4 χρησιµοποιήσαµε στους υπολογισµού και συναρτήσεις του 
MatLab. Συγκεκριµένα είδαµε την τετραγωνική ρίζα sqrt() και το τόξο εφαπτοµένης atan(). 
Το MatLab διαθέτει εκατοντάδες τέτοιες συναρτήσεις τις οποίες θα δούµε αναλυτικότερα 
παρακάτω. Μερικές από τις πλέον χρησιµοποιούµενες συναρτήσεις περιγράφονται στον 
επόµενο πίνακα. Ο πλήρης κατάλογος των συναρτήσεων έχει τοποθετηθεί στα Παραρτήµατα 
του βιβλίου. 
 

Όνοµα 
Συνάρτησης 

Ερµηνεία Παράδειγµα Εντολή Αποτέλεσµα 

sin ηµίτονο ηµ(π) sin(pi)  0.0 
cos συνηµίτονο συν(π) cos(pi)  1.0 
tan εφαπτοµένη εφ(π/4) tan(pi/4)  1.0 
asin τοξο ηµιτόνου τοξηµ(1) asin(1.0) 1.5708 (pi/2) 
atan τοξο εφαπτοµένης τοξεφ(1) atan(1.0) 0.7854 (pi/4) 
exp εκθετικό e1 exp(1.0)  2.7183 
log φυσικός λογάριθµος ln(e) log(2.7183)  1.0 

log10 δεκαδικός λογάριθµος log10(100) log10(100.0)  2.0 
sqrt Τετραγωνική ρίζα √16 sqrt(16.0) 4.0 

 

Οριακοί υπολογισµοί και σφάλµατα 
 
Στις περισσότερες µηχανές τα όρια των αριθµών κυµαίνονται από 10-308 έως 10+308 τα 
οποία είναι αρκετά για τη πλειοψηφία των υπολογισµών. Παρόλα αυτά µπορεί να προκύψει ένα 
αποτέλεσµα έξω από αυτή τη περιοχή. Όταν ένας αριθµός ξεπεράσει τα όρια αυτά, έχουµε 
υπερχείλιση στον εκθέτη (exponent overflow & exponent underflow) και το αποτέλεσµα δεν 
είναι σωστό. Π.χ.: 
 
 Command Window: 

>> x = 2.0e+200 * 3.0e+200  ↵ 
x = 
   Inf 
>> y = 2.0e-200 * 3.0e-200  ↵ 
y = 
     0 
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Η υπερχείλιση προς τα πάνω (overflow) αναφέρεται σαν Inf και η υπερχείλιση προς τα κάτω 
(underflow) στρογγυλοποιείται στο 0. Άλλες περιπτώσεις που συναντάµε συχνά είναι η 
διαίρεση µε το 0 και ο µη-αριθµός. Το αποτέλεσµά της διαίρεση µε το 0 είναι µια άπειρη 
ποσότητα (∞), που αναφέρεται σαν Inf, ενώ το αποτέλεσµα άλλων πράξεων όπως 0/0 είναι 
εντελώς απροσδιόριστο και αναφέρεται σαν NaN (Not-a-Number). 
 
 Command Window: 

>> z = 7.0 / 0.0  ↵ 
Warning: Divide by zero. 
z = 
   Inf 
>> r = 0.0 / 0.0  ↵ 
Warning: Divide by zero. 
r = 
   NaN 

 

Πίνακες και ∆ιανύσµατα (Μητρώα) 
 
Τα µητρώα είναι διατάξεις αριθµών σε γραµµές και στήλες στους οποίους εφαρµόζουµε 
οµοειδείς πράξεις ή µετατροπές µε σκοπό π.χ. τη µετατροπή συντεταγµένων, τη λύση 
συστηµάτων εξισώσεων, την επίλυση προβληµάτων γραµµικής άλγεβρας, τη βελτιστοποίηση 
µεγεθών, κλπ. Π.χ.: 

[ ] [ ]

(1 1) (1 2) (3 1) (2 3)

1
1 2 3

1 1 2 2
4 5 6

3
× × × ×

⎡ ⎤
⎡ ⎤⎢ ⎥
⎢ ⎥⎢ ⎥ ⎣ ⎦⎢ ⎥⎣ ⎦

 

 
Το MatLab κατασκευάστηκε για να διευκολύνει το χειρισµό των µητρώων, κάτι που δεν 
προσφέρει καµία γλώσσα προγραµµατισµού. Το MatLab στην ουσία λειτουργεί µε ένα µόνο 
είδος µεταβλητής, το µητρώο, και κάθε µεταβλητή του MatLab αναφέρεται σε κάποιο 
µητρώο. Όσον αφορά τις διαστάσεις τους, διακρίνουµε 4 κατηγορίες µητρώων: 

1. Τη βαθµωτή ποσότητα, δηλαδή έναν απλό αριθµό, που δεν είναι άλλο παρά ένα 
µητρώο διαστάσεων (1 x 1).  

2. Τα διανύσµατα που είναι µητρώα µε µόνο µια γραµµή (1 x Μ) ή µια στήλη (Ν x 1).  
3. Τα τετραγωνικά µητρώα (Ν x Μ) ή πίνακες τα οποία είναι και τα πιο συνηθισµένα.  
4. Τα τριών και άνω διαστάσεων µητρώα (Ν x Μ x L x …), τα οποία δεν είναι εύκολο 

να παρασταθούν στο επίπεδο (χαρτί ή οθόνη), αλλά χρησιµοποιούνται ευρύτατα από 
όλους τους επιστήµονες, τους µηχανικούς, ή, τους ερευνητές, και το MatLab τα 
χειρίζεται µε την ίδια ευκολία όπως τα υπόλοιπα. 

 
Για να ορίσουµε ένα πίνακα στο MatLab χρησιµοποιούµε τις αγκύλες [ ]. Τα στοιχεία του 
πίνακα που βρίσκονται στην ίδια γραµµή τα χωρίζουµε µε κενά, και τις γραµµές τις χωρίζουµε 
µεταξύ τους µε το ερωτηµατικό (;). Π.χ.: 
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 Command Window: 

>> A = [ 1 2 3 ; 4 5 6]  ↵ 
A = 
     1     2     3 
     4     5     6 
>> B = [ 1 2 3   ↵ 
4 5 6            ↵ 
7 8 9]           ↵ 
B = 
     1     2     3 
     4     5     6 
     7     8     9 
>> C = [1 2 3 4]  ↵ 
C = 
     1     2     3     4 
>> D = [1; 2; 3; 4]  ↵ 
D = 
     1 
     2 
     3 
     4 

 
 
Για να αναφερθούµε σε ένα συγκεκριµένο στοιχείο ενός πίνακα γράφουµε το όνοµα του 
πίνακα και αµέσως µετά σε παρένθεση ( ) γράφουµε τους δείκτες που ορίζουν τη θέση του 
στοιχείου που θέλουµε. Οι δείκτες είναι τόσοι όσες και οι διαστάσεις του πίνακα. Π.χ. 
 
 
 Command Window: 

>> A(2,2), B(3,2)  ↵ 
ans = 
     5 
ans = 
     8 

 
 
Μπορούµε επίσης να επιλέξουµε και µια περιοχή του πίνακα, αν στη θέση κάθε δείκτη 
βάλουµε την αρχική του τιµή, µια άνω κάτω τελεία (:) και τη τελική του τιµή. Π.χ.:  
 
 
 Command Window: 

>> B1 = B(1:2,2:3)  ↵ 
B1 = 
     2     3 
     5     6 

 
 
Τέλος µπορούµε να κατασκευάσουµε µεγάλους πίνακες από άλλους µικρότερους, ή από 
µείγµα πινάκων και στοιχείων. Π.χ.:  
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 Command Window: 

>> E = [ B; 10 11 12; 13 14 15]  ↵ 
E = 
     1     2     3 
     4     5     6 
     7     8     9 
    10    11    12 
    13    14    15 
>> F = [B B]  ↵ 
F = 
     1     2     3     1     2     3 
     4     5     6     4     5     6 
     7     8     9     7     8     9 

 
 
Οι πίνακες που δηµιουργήσαµε µε τις προηγούµενες εντολές βρίσκονται όλοι στη περιοχή 
εργασίας µας και εµφανίζονται στο παράθυρο Workspace: 
 

 
 
Από το παράθυρο Workspace µπορούµε να επιλέξουµε να επεξεργαστούµε ένα πίνακα µε 
τον Array Editor ή να τον παρουσιάσουµε σαν διάγραµµα, ιστόγραµµα, κλπ. Π.χ. για τον 
πίνακα F θα έχουµε αντίστοιχα: 
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Συναρτήσεις για ∆ηµιουργία Πινάκων 
 
Το MatLab διαθέτει επιπλέον εντολές για την δηµιουργία πινάκων ειδικής µορφής. Η zeros() 
δηµιουργεί πίνακες µε όλα τα στοιχεία 0, η ones() δηµιουργεί πίνακες µε όλα τα στοιχεία 1, 
και, η eye() δηµιουργεί το µοναδιαίο πίνακα. Π.χ.: 
 
 Command Window: 

>> Q = zeros(3,3)  ↵ 
Q = 
     0     0     0 
     0     0     0 
     0     0     0 
>> P = ones(3,3)  ↵ 
P = 
     1     1     1 
     1     1     1 
     1     1     1 
>> I = eye(3)  ↵ 
I = 
     1     0     0 
     0     1     0 
     0     0     1 

 
Άλλες συναρτήσεις χρήσιµες για τη δηµιουργία πινάκων είναι οι: 
 

Όνοµα Συνάρτησης Ερµηνεία 
rand γενήτρια τυχαίου πίνακα 
magic µαγικά τετράγωνα 
hilb πίνακας Hilbert 
triu άνω τριγωνικός πίνακας 
tril κάτω τριγωνικός πίνακας 
diag ορισµός ή εµφάνιση της διαγωνίου 

 
 
Εκτός από τις παραπάνω µεθόδους µπορούµε να δηµιουργήσουµε διανύσµατα µε 
επαναληπτική µέθοδο, δίνοντας την αρχική τιµή, το βήµα και τη τελική τιµή που θα έχουν τα 
στοιχεία τους: 
 
 Command Window: 

>> X = 1:5  ↵ 
X = 
     1     2     3     4     5 
>> Y = -8:2:8  ↵ 
Y = 
    -8    -6    -4    -2     0     2     4     6     8 
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Πράξεις µε πίνακες 
 
Οι βασικές πράξεις µε πίνακες είναι οι: 
 
� Πρόσθεση ( + ),  
� Αφαίρεση ( - ),  
� Πολλαπλασιασµός ( * ),  
� Ύψωση σε ∆ύναµη ( ^ ) 
� ∆ιαίρεση ( / )  & Αριστερή ∆ιαίρεση ( \ ) 
� Ανάστροφος ( ' )  

 
 Command Window: 

>> (2*P-I)/2  ↵ 
ans = 
    0.5000    1.0000    1.0000 
    1.0000    0.5000    1.0000 
    1.0000    1.0000    0.5000 
>> A'  ↵ 
ans = 
     1     4 
     2     5 
     3     6 
>> A*A'  ↵ 
ans = 
    14    32 
    32    77 

 
 
Η πρόσθεση και η αφαίρεση πινάκων γίνονται στοιχείο-στοιχείο ενώ οι άλλες πράξεις (* , ^ , / 
, \) γίνονται σαν πράξεις µητρώων. Το MatLab µας δίνει τη δυνατότητα να αναγκάσουµε και 
τις άλλες πράξεις να γίνουν στοιχείο-στοιχείο αν βάλουµε µια τελεία πριν το σύµβολο της 
πράξης, δηλαδή (.* ,  .^ ,  ./ ,  .\ ). Π.χ.:  
 
 Command Window: 

>> [1 2 ; 3 4]^2  ↵ 
ans = 
     7    10 
    15    22 
>> [1 2 ; 3 4].^2  ↵ 
ans = 
     1     4 
     9    16 

 
Οι πράξεις στοιχείο-στοιχείο είναι πολύ χρήσιµες και στη γραφική απεικόνιση των 
αποτελεσµάτων µας. Εδώ ας σηµειώσουµε ότι, όταν κάνουµε πράξεις πινάκων µε βαθµωτά 
µεγέθη αυτές γίνονται πάντοτε στοιχείο-στοιχείο. 
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Το MatLab διαθέτει πολλές επιπλέον εντολές (συναρτήσεις) για ειδικές, ή πολύπλοκες, ή πολύ 
συχνές πράξεις πινάκων, όπως είναι η inv() που υπολογίζει τον αντίστροφο ενός πίνακα, η 
max() που επιστρέφει το µέγιστο στοιχείο του πίνακα, ή, η eig() που υπολογίζει τις ιδιοτιµές 
και τα ιδιοδιανύσµατα ενός πίνακα. Λόγω του µεγάλου πλήθους των συναρτήσεων του 
MatLab, ο πλήρης κατάλογος µε όλες τις συναρτήσεις έχει τοποθετηθεί στα Παραρτήµατα 
του βιβλίου. 
 
 

Γραφικές Παραστάσεις 
 
 
Τα αποτελέσµατα των εργασιών σχεδόν πάντοτε περιέχουν και διαγράµµατα ή γραφικές 
παραστάσεις. Οι γραφικές παραστάσεις είναι επίσης ο καλύτερος τρόπος για να παρουσιάσει 
κανείς µεγάλο αριθµό αποτελεσµάτων και για να εξάγει γενικά συµπεράσµατα που δεν είναι 
προφανή από τους αριθµούς και µόνο. 
 
Το MatLab διαθέτει ένα µεγάλο αριθµό ευέλικτων εντολών για τη δηµιουργία γραφικών που 
καλύπτουν όλες τις ανάγκες του χρήστη, από τα απλά και γρήγορα γραφικά για το 
εργαστηριακό φύλλο έργου, µέχρι τα γραφικά µε τις ειδικές προδιαγραφές που δηµοσιεύονται 
σε διεθνή επιστηµονικά περιοδικά. 
 
Οι πιο απλές εντολές για να δηµιουργηθεί ένα γραφικό περιέχονται στον πίνακα που 
ακολουθεί: 
 
 

Εντολή Ερµηνεία 
plot(x,y) σχεδιάζει το  y  vs  x 
plot(x,y1,x,y2,x,y3) σχεδιάζει τα  y1, y2 & y3  vs  x  στο ίδιο γραφικό 
xlabel('X label') βάζει ετικέτα στον άξονα των Χ 
ylabel('Y label') βάζει ετικέτα στον άξονα των Υ 
title ('Title') βάζει τίτλο επάνω από το γραφικό 
grid προσθέτει ένα πλέγµα κάθετων & οριζόντιων γραµµών 
gtext('Text') προσθέτει όποιο κείµενο θέλουµε στο σηµείο που θα 

δείξουµε µε το ποντίκι. 
 
 
 
Τα δεδοµένα που θέλουµε να σχεδιάσουµε θα έχουν προκύψει από τις προηγούµενες εντολές 
ή από κάποιο αρχείο. Εδώ θα τα δηµιουργήσουµε µε δυο εντολές. Πρώτα δηµιουργούµε το 
διάνυσµα Χ το οποίο αρχίζει από το -400 και µε βήµα 1 φτάνει στο 400 και περιέχει 801 
στοιχεία. Στη συνέχεια δηµιουργούµε το Υ δηλαδή τη συνάρτηση που θέλουµε να 
σχεδιάσουµε και η οποία είναι:  Υ = ηµ(Χ/100). Εφόσον το Χ είναι διάνυσµα, και το Υ θα 
είναι διάνυσµα µε το ίδιο µήκος. Τέλος δίνουµε την εντολή  plot(X,Y). και εµφανίζεται η 
γραφική παράσταση. 
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 Command Window: 

>> x = -400:400 ;  y = sin(x/100);  ↵ 
>> plot(x,y)  ↵ 

 

 
 
Στη συνέχεια θα δηµιουργήσουµε µερικές ακόµα συναρτήσεις, θα τις σχεδιάσουµε όλες µαζί 
και θα προσθέσουµε πλέγµα, ετικέτες και τίτλους µε τις εντολές του προηγουµένου πίνακα. 
 
 Command Window: 

>> y1 = 0.5*sin(x/200) ; y2 = 0.7*sin(x/25);  ↵ 
>> plot(x,y,x,y1,x,y2)  ↵ 
>> grid  ↵ 
>> xlabel('Etiketa tou Axona X')  ↵ 
>> ylabel('Etiketa tou Axona Y')  ↵ 
>> title('Titlos Grafikis Parastasis')  ↵ 
>> gtext('y'), gtext('y1'), gtext('y2')  ↵ 

 

 
 



Βασικός Προγραµµατισµός στο MatLab Β. Χ. Μούσας Σελ. 25 

 

 
Για τις τρισδιάστατες (3-D) γραφικές  παραστάσεις, το MatLab διαθέτει ειδικές εντολές όπως 
είναι η mesh(), surf(), κ.ά., που σχεδιάζουν τα δεδοµένα στους άξονες Χ-Υ-Ζ. 
 
Για παράδειγµα για να σχεδιάσουµε την συνάρτηση:   z = x · exp( - x2 - y2 )  στο διάστηµα  
-2 < x < 2 και -2 < y < 2  δίνουµε τις εντολές: 
 
 Command Window: 

>> [x,y] = meshgrid( -2:.1:2, -2:.1:2);  ↵ 
>> z = x .* exp( -x.^2 - y.^2);  ↵ 
>> mesh(z)  ↵ 

 
 

 
 

Μετατροπή της εργασίας µας σε πρόγραµµα (M-file) 
 
Όλα τα παραπάνω παραδείγµατα που δείξαµε αλλά και η συντριπτική πλειοψηφία των 
εργασιών στο MatLab απαιτούν περισσότερες από µια εντολές για να ολοκληρωθούν. 
Επιπλέον, κάθε φορά που αλλάζει κάτι στα δεδοµένα, θα πρέπει να ξαναγράφονται και να 
εκτελούνται όλες οι εντολές µε τη σειρά. Ας µη ξεχνάµε όµως ότι, σκοπός της χρήσης του 
υπολογιστή δεν είναι µόνο να κάνει γρήγορα µια πράξη αλλά και να µπορεί να την επαναλάβει 
αργότερα χωρίς να χρειάζεται να του ξαναδοθούν όλες οι οδηγίες µια-µια.  
 
Για να γίνει λοιπόν σωστή και αποδοτική χρήση της εφαρµογής του MatLab σε ένα Η/Υ θα 
πρέπει οι εργασία µας, αφού περάσει το δοκιµαστικό στάδιο, να πάρει τη µορφή 
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προγράµµατος ώστε να αποθηκευτεί στον Η/Υ και να είναι διαθέσιµη σε κάθε επόµενη χρήση 
ή βελτίωση. 
 
Η διαδικασία µετατροπής µιας ακολουθίας εντολών του CW σε πρόγραµµα είναι απλούστατη. 
Αντιγράφουµε όλες τις εντολές µε την ίδια σειρά σε ένα αρχείο κειµένου και το αποθηκεύουµε 
µε ένα όνοµα και µε επέκταση (.m). Από τη στιγµή αυτή έχουµε δηµιουργήσει ένα 
πρόγραµµα, µια νέα εντολή ή συνάρτηση του MatLab, και όταν θα γράφουµε το όνοµα του 
προγράµµατος µας στο CW θα εκτελούνται µε τη σειρά όλες οι εντολές που περιέχει.  
 

Παράδειγµα 5: M-file µε Γραφικές παραστάσεις 
 
Για παράδειγµα, οι γραφικές παραστάσεις της προηγούµενης παραγράφου απαιτούσαν πάνω 
από 10 εντολές για να πραγµατοποιηθούν. Ας δούµε πως όλες αυτές τις εντολές τοποθετούνται 
σε ένα πρόγραµµα, και τι επιπλέον δυνατότητες µας παρέχονται όταν τις εκτελούµε σαν 
πρόγραµµα του MatLab. 
 
Ανοίγουµε τον Editor από το µενού File > New > M-file και αντιγράφουµε από το CW 
όλες τις εντολές που δώσαµε στη προηγούµενη παράγραφο. Το αποθηκεύουµε µε το όνοµα: 
graph_test.m, δίνουµε στο CW την εντολή:  >> graph_test και παρατηρούµε τα γραφικά να 
δηµιουργούνται. 
 

 
 
Για να διακρίνεται το παράθυρο του Editor µε τα M-files από το παράθυρο εντολών (CW), 
στο βιβλίο αυτό θα παριστάνεται πάντα µε την παρακάτω µορφή: 
 
 M-file: graph_test.m 

x = -400:400 ;   
y = sin(x/100);   
y1 = 0.5*sin(x/200);  
y2 = 0.7*sin(x/25);   
plot(x,y,x,y1,x,y2)   
grid   
xlabel('Etiketa tou Axona X')   
ylabel('Etiketa tou Axona Y')   
title('Titlos Grafikis Parastasis')   
gtext('y') 
gtext('y1') 
gtext('y2')   
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Όταν µεταφέρουµε την εργασία µας σε ένα M-file µας δίνεται η δυνατότητα να προσθέσουµε 
και βοηθητικές εντολές οι οποίες εξυπηρετούν στην καλύτερη ανταλλαγή πληροφοριών µε τον 
χρήστη του τελικού προγράµµατος. Μπορούµε να προσθέσουµε εντολές εισόδου όπως η 
input που θα ζητάνε από τον χρήστη δεδοµένα, εντολές εξόδου όπως η disp που θα 
εµφανίζουν στο χρήστη µηνύµατα ή αποτελέσµατα, εντολές µορφοποίησης των 
αποτελεσµάτων όπως οι fprintf & sprintf, ακόµη και γραµµές µε επεξηγηµατικά σχόλια οι 
οποίες αρχίζουν µε το σύµβολο (%), δεν λαµβάνονται υπ’ όψιν από το MatLab, και 
απευθύνονται στον χρήστη που δηµιουργεί το M-file. 
 

Παράδειγµα 6: Πρόγραµµα µετατροπής Μοιρών σε Ακτίνια 
 
Στο Παράδειγµα 1 είδαµε µε ποια εντολή στο CW µετατρέπουµε τις µοίρες σε ακτίνια. Η 
µετατροπή αυτή είναι χρήσιµη γιατί όλοι µιλάµε µε µοίρες αλλά οι τριγωνοµετρικές 
συναρτήσεις στους Η/Υ λειτουργούν κυρίως µε ακτίνια (rad). Εδώ, θα δηµιουργήσουµε ένα 
πρόγραµµα MatLab (M-file) που θα κάνει τη µετατροπή αυτή. Γράφουµε τις εντολές του 
Παραδείγµατος 1 στον Editor και αποθηκεύουµε το M-file µε το όνοµα m2a.m 
 
 M-file:  m2a.m 

moires = 45 
aktinia = moires * pi / 180 

 
Εκτελώντας την νέα µας εντολή (M-file) m2a στο CW, θα έχουµε: 
 
 Command Window: 

>> m2a  ↵ 
moires = 
    45 
aktinia = 
    0.7854 

 
Το «πρόγραµµά» µας δουλεύει µια χαρά αλλά είναι πρακτικά άχρηστο γιατί υπολογίζει µόνο 
µια γωνία, αυτή των 45ο. Για να το κάνουµε σωστό πρόγραµµα, θα του προσθέσουµε µια 
εντολή που θα ζητά από τον χρήστη (input) τις µοίρες της γωνίας και άλλη µια που θα δίνει 
την απάντηση (disp). Θα προσθέσουµε επίσης δυο µηνύµατα ('…') και επεξηγηµατικά σχόλια 
(%) για κάθε εντολή. 
 
 M-file:  m2a.m 

%  Entoli Eisodou, me erwtisi gia tis moires 
moires = input('DWSE TH GWNIA SE MOIRES: '); 
 
%  Entoli Ypologismou twn aktiniwn 
aktinia = moires * pi / 180; 
 
%  Entoles Exodou, me to minyma kai to apotelesma se aktinia 
disp('H GWNIA SE AKTINIA EINAI');  
disp(aktinia); 
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Εκτελώντας τώρα το πρόγραµµα στο CW, θα πάρουµε ένα σαφώς καλύτερο αποτέλεσµα: 
 
 Command Window: 

>> m2a  ↵ 
DWSE TH GWNIA SE MOIRES: 33  ↵ 
H GWNIA SE AKTINIA EINAI 
    0.5760 
>> m2a  ↵ 
DWSE TH GWNIA SE MOIRES: 180  ↵ 
H GWNIA SE AKTINIA EINAI 
    3.1416 

 
Για να ολοκληρώσουµε το πρόγραµµα πρέπει να προσθέσουµε στην αρχή 2-3 γραµµές 
σχολίων που θα το περιγράφουν. Η περιγραφή θα πρέπει να περιλαµβάνει τουλάχιστον το 
όνοµα του, τη λειτουργία του και τις ενέργειες του χρήστη. Μια πιθανή τελική µορφή του 
προγράµµατός µας είναι η παρακάτω: 
 
 M-file:  m2a.m 

%  m2a.m 
%  Programma metatropis Moirwn se Aktinia: 
%     O xristis dinei ti gwnia se moires, 
%     kai to programma tin ypologizei se aktinia.  
 
%  Entoli Eisodou, me erwtisi gia tis moires 
moires = input('DWSE TH GWNIA SE MOIRES: '); 
 
%  Entoli Ypologismou twn aktiniwn 
aktinia = moires * pi / 180; 
 
%  Entoles Exodou, me to minyma kai to apotelesma se aktinia 
disp('H GWNIA SE AKTINIA EINAI');  
disp(aktinia); 

 
Το MatLab έχει ένα πολύ χρήσιµο χαρακτηριστικό, όταν δώσουµε την εντολή help και το 
όνοµα ενός προγράµµατος, χρησιµοποιεί τις πρώτες γραµµές σχολίων του προγράµµατος και 
τις παρουσιάζει στην οθόνη σαν βοήθεια προς τον χρήστη. Έτσι, ότι γράψουµε στα πρώτα 
σχόλια αποτελεί και τις οδηγίες, τη βοήθεια ή το manual του προγράµµατός µας. Πράγµατι 
αν δώσουµε στο CW την εντολή θα έχουµε:  
 
 Command Window: 

>> help m2a  ↵ 
  m2a.m 
  Programma metatropis moirwn se aktinia: 
     O xristis dinei ti gwnia se moires, kai 
     to programma tin ypologizei se aktinia.  
>> 
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Παράδειγµα 7: Συνάρτηση µετατροπής Μοιρών σε Ακτίνια 
 
Το πρόγραµµα που φτιάξαµε στο προηγούµενο παράδειγµα µπορεί να εκτελεστεί µόνο από 
τον χρήστη. Όµως οι µετατροπές των γωνιών είναι συχνά χρήσιµες και µέσα σε άλλα 
προγράµµατα. Για να µπορεί ένα πρόγραµµα να κληθεί από ένα άλλο πρόγραµµα πρέπει να 
το κάνουµε συνάρτηση (function). Η συνάρτηση είναι ένα υποπρόγραµµα και διαφέρει από τα 
προγράµµατα µόνο στον τρόπο µε τον οποίο παίρνει τα δεδοµένα και επιστρέφει το 
αποτέλεσµα.  
 
Οι συναρτήσεις δέχονται τα δεδοµένα από την παρένθεση που ακολουθεί το όνοµά τους, και 
επιστρέφουν την απάντηση στη θέση του ονόµατός τους, σαν να ήταν µεταβλητές. 
 
Για να µετατρέψουµε το m2a.m σε συνάρτηση πρέπει να κάνουµε τις παρακάτω αλλαγές στην 
αρχή και στο τέλος του προγράµµατος. Η πρώτη εντολή θα πρέπει να είναι η εντολή 
function, και θα περιέχει τη µεταβλητή που επιστρέφει η συνάρτηση, το = , το όνοµά της, και, 
τη παρένθεση µε τη µεταβλητή εισόδου (δεδοµένα) της συνάρτησης. Στη συνέχεια 
διαγράφουµε όλες τις άλλες εντολές εισόδου και εξόδου (input, disp, κλπ.). 
 
 M-file:  m2a.m 

function aktinia = m2a(moires) 
%  m2a.m 
%  Synartisi metatropis moirwn se aktinia 
%  Syntax: aktinia = m2a(moires) 
%  Input: moires, Output: aktinia 
aktinia = moires * pi / 180; 

 
Μπορούµε τώρα να εκτελέσουµε τη συνάρτηση µέσα σε οποιοδήποτε άλλο πρόγραµµα. Για 
να θυµηθούµε τη σύνταξή της δίνουµε help m2a και εµφανίζονται οι γραµµές µε τα σχόλια 
που γράψαµε. Αν τώρα µια µεταβλητή π.χ., akt180 πρέπει να περιέχει τα ακτίνια των 180 
µοιρών θα γράψουµε τη εντολή: akt180 = m2a(180). 
 
 Command Window: 

>> help m2a  ↵ 
  m2a.m 
  Synartisi metatropis moirwn se aktinia 
  Syntax: aktinia = m2a(moires) 
  Input: moires, Output: aktinia 
 
>> akt180 = m2a(180)  ↵ 
akt180 = 
    3.1416 
>> 

 
 
Όπως βλέπουµε, τα M-files του MatLab εκτός από τις απλές εντολές ανάθεσης, µπορεί να 
περιέχουν και άλλα είδη εντολών όπως: εντολές που πραγµατοποιούν επαναλήψεις (for), 
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εντολές σύγκρισης ή ελέγχου (if, case), εντολές µορφοποίησης της εξόδου (fprintf), εντολές 
χειρισµού αρχείων και Ι/Ο, και άλλες που θα τις δούµε πιο αναλυτικά στα επόµενα κεφάλαια. 
 
Το MatLab λοιπόν, εκτός από αλληλεπιδραστικό περιβάλλον είναι ταυτόχρονα και 
προγραµµατιστικό περιβάλλον. Επιπλέον, κάθε πρόγραµµα (M-file) που φτιάχνουµε είναι 
ταυτόχρονα και µια νέα εντολή ή συνάρτηση του MatLab. Αυτή η ιδιότητα δίνει στο πακέτο 
τη δυνατότητα να προσαρµόζεται στις ανάγκες µας και να επεκτείνεται και να ενηµερώνεται 
απεριόριστα. Σήµερα έχουµε στη διάθεσή µας εκατοντάδες τέτοιες προσθήκες οι οποίες 
αναπτύχθηκαν από επιστήµονες που χρησιµοποιούσαν το MatLab. Τα συµπληρωµατικά αυτά 
πακέτα µε αρχεία (M-files) ονοµάζονται Toolbox και προσθέτουν πληθώρα εντολών και 
συναρτήσεων στις ήδη υπάρχουσες, διευκολύνοντας ακόµη περισσότερο τους υπόλοιπους 
χρήστες. 
 

Άλλες Εντολές ή Ρυθµίσεις 
 

Path 
 
Για να λειτουργήσει οµαλά το περιβάλλον του MatLab, θα πρέπει να έχει πρόσβαση σε όλους 
τους φακέλους που περιέχουν τις εντολές και τα M-file. Αυτό γίνεται µε τη ρύθµιση του 
search path του MatLab. Το search path πρέπει να περιέχει όλες τις διαδροµές των 
φακέλων που περιέχουν αρχεία του MatLab (M-file), τα πρόσθετα Toolbox, ή τον φάκελο µε 
τις εργασίες µας. Το search path του MatLab ρυθµίζεται µέσα από το µενού: File > Set 
Path…  προσθέτοντας και αφαιρώντας φακέλους στο αντίστοιχο παράθυρο που εµφανίζεται. 
Η σειρά εµφάνισης στο search path είναι σηµαντική όταν υπάρχουν δυο M-file µε το ίδιο 
όνοµα σε διαφορετικούς φακέλους καθώς θα εκτελείται πάντα αυτό που προηγείται. 
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Ηµεροµηνία 
 
Το MatLab διαθέτει επίσης εντολές σχετικές µε την ηµεροµηνία και ώρα του συστήµατός µας. 
Η εντολή date εµφανίζει την τρέχουσα ηµεροµηνία του Η/Υ και είναι ιδιαίτερα πρακτική για 
τη χρονική σήµανση δεδοµένων, αποτελεσµάτων και αρχείων καταγραφής (diary). Πιο 
ολοκληρωµένη είναι η εντολή clock η οποία δίνει την ηµεροµηνία και την ώρα του 
συστήµατος µε τρόπο ώστε να είναι επεξεργάσιµη από άλλες εντολές ή προγράµµατα. Η 
έξοδος της clock είναι ένα διάνυσµα 6 στοιχείων µε τη συγκεκριµένη σειρά: [ έτος  µήνας  
ηµ/νία  ώρα  λεπτά  δεύτερα ]. Η έξοδος της clock είναι σε εκθετική µορφή αλλά µπορεί να 
γίνει ακέραια µε τη βοήθεια της fix(). 
 
 
 Command Window: 

>> date  ↵ 
ans = 
23-Feb-2006 
 
>> clock  ↵ 
ans = 
  1.0e+003 * 
    2.0060    0.0020    0.0230    0.0100    0.0160    0.0423 
 
>> fix(clock)  ↵ 
ans = 
      2006           2          23          10          16          
45 

 
 

Ταχύτητα εκτέλεσης 
 
Η ταχύτητα εκτέλεσης των εντολών είναι επίσης σηµαντική για τα περισσότερα επιστηµονικά 
προβλήµατα. Αλλιώς σχεδιάζεται µια προσοµοίωση που τρέχει µέσα σε 10 λεπτά και αλλιώς 
µια που χρειάζεται 2 µέρες για να ολοκληρωθεί. Για να έχουµε µια εκτίµηση της απόδοσης 
του Η/Υ που χρησιµοποιούµε, το MatLab διαθέτει ένα δικό του τεστ επιδόσεων. Η σύγκριση 
των επιδόσεων του Η/Υ µας µε άλλα συστήµατα αναφοράς, γίνεται µε την εντολή bench.  
 
Για παράδειγµα για έναν Η/Υ µε επεξεργαστή Intel Pentium 4, στα 1.5 GHz η εντολή δίνει 
τα παρακάτω συγκριτικά αποτελέσµατα.  
 
 
 Command Window 

>> bench  ↵ 
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